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Welcome!
Thank you for purchasing the Lorex LIVE video monitor. This user’s 
guide refers to the following models:

• LW2400

Contents
Before you start, make sure you have the contents listed below.

• 1x Video monitor

• 1x Camera

• 1x Video monitor power adapter

• 1x Camera power adapter

• 1x mini-USB cable

• 1x User’s guide

• 1x Quick start guide

• 1x Driver CD

• 1x Mounting screw kit

• 3x Cable clips
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Safety Instructions
WARNING
This video monitor is compliant with all relevant standards regarding 
electromagnetic fields and is, when handled as described in the User’s 
Guide, safe to use. Therefore, always read the instructions in this 
user’s guide carefully before using the device.

• Adult assembly is required. Keep small parts away from children when 
assembling.

• This product is not a toy. Do not allow children to play with it.
• This video monitor is not a substitute for responsible adult supervision.
• Keep the cords out of reach from children.
• Do not cover the video monitor with a towel or blanket.
• Never use extension cords with power adapters.
• Only use the power adapters provided.
• Test the video monitor before use. Become familiar with its functions.
• Do not use the video monitor near water.
• Do not install the video monitor near a heat source.
• Only insert batteries/battery pack of the same type.
• Do not touch the plug contacts with sharp or metal objects.

Only use the chargers and power adapters provided. Do not use other chargers 
or power adapters as this may damage the device and battery pack.

• Keep this user’s guide for future reference.

CAUTION
Risk of explosion if battery is replaced by an incorrect type. 

• DISPOSE OF OR RECYCLE BATTERIES PROPERLY IN ACCORDANCE WITH 
APPLICABLE LAWS, which may vary by location.

• Insert batteries with the correct polarity.
• Do not mix new and used batteries.
• Do not mix alkaline, standard, and rechargeable batteries.
• Remove exhausted batteries from the product.
• Keep all batteries away from children.
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Using this product as a baby monitor
If you intend to use this wireless video monitor as a baby monitor, we 
advise you to take the following precautions to avoid possible injury to 
infants:

• DO NOT place baby audio and video camera monitors too close to cribs, 
bassinets, play yards, and other safe sleep environments for infants. 

• MAKE SURE to run all power adapter cords where they are unlikely to 
be tripped over and are out of arms reach of your infant. Keep them 
at least 3 ft./1m away

• MAKE SURE baby audio and video camera monitors are on a stable 
footing so they cannot be easily knocked over

• Use the included cable clips to keep the power cord out of reach from 
infants and young children.

NOTE: These precautions are important even if your infant is not yet 
standing or mobile.

3 ft./1m

Using the cable clips

Option 1:
Thread the extra cable through 
the cable clip notches.

Option 2:
Thread the extra cable through 
the cable clip notches. Wrap the 
excess cable around the clip.

Option 3:
Wrap the excess cable around the 
clip.
iii
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Video monitor overview
Video monitor

Video Button
Press the Video button to 
turn off the screen until the 
Video button is pressed 
again. The speaker will 
remain on.

Press to access the monitor menu 
options. Press Menu again to exit.

Joystick
Use to navigate monitor 
menus. Press down on the 
joystick to confirm a 
selection.

Volume Control
Press + / - to control the 
volume level.

Audio Level Indicator
Displays the level of sound 
detected by the camera.

Menu Button

Talk Button
Hold the talk button to 
enable two-way audio 
between the video monitor 
and camera.

ON/OFF Switch
Slide the power switch to the 
ON position to turn the video 
monitor on.

Music Buttons
Press the button once to 
begin playing a tune. Press 
the button again to stop 
the tune.

Press the button to skip to 
the next tune.

Power LED
Glows green to indicate unit 
is powered on. Blinks when 
the battery is low.

Microphone
Allows you to speak to the 
person on the camera side 
when you press the Talk 
button.

Slide the switch to release the 
monitor antenna.

Antenna Unlock Switch

Sequence/Quad Button
Press the Sequence/Quad button 
to view video in Quad view (4 screen 
split view), or in Sequence view.

Scan Button
Turns off the video monitor, and 
waits for a camera to detect a 
sound. When sound is detected, 
the video monitor turns back on.

Charging LED Indicator
Glows red to indicate video 
monitor is charging.
Glows green to indicate video 
monitor is finished charging.

Cam Button
Press the Cam button to manually 
switch between channels 1-4.

Power Port
Connect the power adapter 
into the power port to charge 
the video monitor.

Mini-USB Port
Connect a mini-USB cable 
(included) between the video 
monitor and a computer to 
view video remotely using 
Skype (setup required).

SCANLights up when the video 
monitor is in Scan mode. 

SCAN LED

 overview
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Video monitor overview
Using the joystick to navigate menus
The joystick allows you to navigate through the video monitor menus.

OK Button

Step 1: Press the Menu button on the 
video monitor.

Step 2: Move the joystick up, down, 
left, or right to navigate through the 
menus.

Step 3: Press down on the OK button 
to confirm a selection or press Menu 
to exit menus without saving 
changes.

Menu Navigation

Speaker
Plays sound received from the 
camera(s).

Kickstand
2



Video monitor overview
Monitor display icons

Icon Meaning

No signal between the camera and video monitor.

Full signal between the camera and video monitor.

Timer is enabled.

The video monitor audio is muted.

The camera night light is on.

Talk function is enabled. You can now speak into the 
video monitor to talk to the camera. Release the Talk 
button on the video monitor to listen to audio from the 
camera.

Indicates what channel the video monitor is on.

CHARGE
BATTERY

The video monitor battery is low. 

OUT OF 
RANGE

The camera is out of range. Move the camera closer to 
the video monitor.

CAM1
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Camera overview
Camera overview

 Infrared LEDS
Infrared (IR) LEDs that allow 
you to see in the dark.

Sensitivity Dial
Adjust the audio level that 
will trigger an alert on the 
video monitor.

Volume Dial
Adjusts the speaker volume.

Power Switch
Turns the camera on and off.

Speaker
The speaker allows you to 
hear the person speaking 
into the video monitor.

Power Port (DC5V)
Connect the power 
adapter.

Microphone

Pair Button
Press the Pair button 
during the pairing 
process with the video 
monitor. 

Temperature Sensor
Detects the room’s ambient 
temperature.

IR Light Sensor

Night Light Button
Press to activate the 
camera’s night light.

Power LED
Glows to indicate camera is 
on.

Detects the level of light in 
the room to trigger night 
vision.

Wall Mounting Hole
Connect the stand here to 
wall mount the camera.
4



Getting started
Getting started
Step 1 of 2: Powering on the camera

1 Connect the power adapter to the DC5V port on the camera. Connect the other end to a power 
outlet. 

2 Slide the power switch to the ON position.

Slide the power switch 
to the ON position

1 2

ATTENTION
• Keep cables and wires at least 3 feet (1 meter) away from infants or young 

children. 
• Use the cable clips to keep the power cords out of reach.

Use the cable clips to secure and manage the 
cables. You can wrap the excess cable around the 
security clip to reduce the cable length.

NOTE: For wall mounting instructions, see page 44.
5



Getting started
Step 2 of 2: Powering on the video monitor
1 Connect the power adapter to a power outlet and to the DC5V port on the video monitor. The 

video monitor’s charging LED indicator glows red to indicate charging is in progress. The 
charging LED glows green when the video monitor is fully charged.
NOTE: It requires 6 hours to fully charge the battery.

2 Slide the power switch to ON.

DC5V port

Slide the power switch to 
the ON position

The video monitor will automatically scan for cameras in range.

Testing your setup
It is recommended that you test your camera setup before permanent installation so that 
you get the best picture and sound quality from your video monitor.

Test the camera and video monitor reception:
1 Place the camera and video monitor in two different rooms.

2 Have one person monitor the signal strength on the video monitor.

3 If the signal strength is low, have a second person move the camera to different locations in 
the room to find the best placement location. 

Test the camera volume level:
1 Have a person with the video monitor press and hold the TALK button to confirm the camera 

volume level. Have the other person adjust the volume dial on the camera as required.

2 Have the person near the camera speak into it to test the sound quality on the video monitor. 
The person holding the video monitor can determine if the camera needs to move to a 
different location in the room for better sound clarity.
6



Getting started
Camera setup

Adjusting the camera 
sensitivity
The camera’s Sensitivity dial allows you 
to adjust the microphone sensitivity 
level for triggering an alert on the video 
monitor.
To adjust the camera’s sensitivity level:
• Scroll the Sensitivity dial to increase 

camera sensitivity (i.e. softer noises 
trigger the camera) or reduce 
sensitivity (i.e. louder noises trigger the 
camera).

Adjusting the camera volume
The camera’s speaker volume can be 
adjusted to the desired level. Scroll the 
Volume dial to increase or decrease the 
camera volume.

Turning on the camera night 
light
• Press the Night Light button on the top of the 

camera to turn the night light on or off. The 
night light button glows when the night light 
is on and the monitor displays the  icon to 
indicate the camera night light is on.

Video monitor setup

Unlocking the video monitor 
antenna
The video monitor has a built-in antenna that 
improves signal range. It is recommended that 
you extend antenna for optimal performance.
To unlock the monitor antenna:
• Slide the lock button to the right. 

Night Light Button
Press the Night Light 
button to turn the camera 
night light on or off.

Adjust the camera volume
Adjust the speaker volume.

Adjust the audio sensitivity
Adjust the audio level that will 
trigger an alert on the video monitor.

Slide the Lock button to the 
right to release the antenna
7



Getting started
Reading the power indicator LED
The power indicator LED glows green when the monitor is powered on. When the battery 
is low, the power LED blinks.

Power LED

Sequence view
In Sequence view, the monitor switches between paired cameras every six seconds. For 
example, the monitor displays channel 1 for six seconds, then channel 2 for six seconds 
and so on. The monitor only switches to channels that are paired with a camera.
To enable Sequence view:
• Press the SEQ/Quad button once to enter Sequence view. 
To exit Sequence view:
• Press the CAM button.

Viewing multiple cameras (Quad view)
You can view all of the paired cameras in Quad view. The video monitor supports a 
maximum of four cameras.
NOTE: Audio monitoring is not available in Quad view.

SEQ/Quad button

Camera 1

Camera 4 Camera 3

Camera 2

How Sequence View works
8



Getting started
To view multiple cameras in Quad view:
• Press the SEQ/Quad button twice on the video monitor.
To exit Quad view:
• Press the SEQ/Quad button, and then press CAM to exit Sequence view and return to 

single-camera view.

Using the talk function
The talk function allows you to speak into the video monitor and have the camera speaker 
play your voice. The camera also has a built-in microphone, which allows the person to 
speak into the camera.

Hello HelloTalk and listen 
(Two-way communication)

To use the talk function:
1 Adjust the volume on the camera and video monitor to the desired level.

2 Press and hold the Talk button on the video monitor and begin speaking. Release the Talk 
button when you are finished.
NOTE: You must release the Talk button on the video monitor in order to listen to the audio 

from the camera.

NOTE: The talk function does not work in Quad view.

SEQ/Quad button

Video monitor displays up to 4 video 
images in Quad view
9



Getting started
Music
The music feature allows the camera to play pre-loaded tunes. 

Play/stop music Next tune

To use the music feature:
• Press the  button to begin playing a tune on the camera and video monitor.
• Press the  button again to stop the tune.
• Press the  button to skip to the next tune. The song title appears on-screen.
NOTE: Music is not available in Quad view.

Using Scan mode
Scan mode temporarily turns off the video monitor, and waits for a camera to detect a 
noise. Once one of the cameras detect sounds, the video monitor automatically turns on, 
and beeps to notify you. This feature is especially useful if you have multiple cameras, and 
only want to view the camera that detects a sound (e.g. infant crying).

To enable Scan mode:
• Press the Scan button.

To disable the Scan mode:
• Press the Scan button to turn off Scan mode.

NOTE: The first camera to detect a sound will trigger the video monitor to turn on. After 
several seconds, the monitor turns off and begins monitoring the cameras again.

Scan button
10



Getting started
Turning the video monitor screen on/off
You can turn off the video monitor screen while still listening to audio from the camera. For 
example, you can monitor audio from a baby’s room while you sleep and turn off the video 
monitor screen to conserve power.
To turn the video monitor screen on/off:
• Press the Video button to turn the screen off. 
• Press the Video button again to turn the screen on.

Video button
11



Configuring your video monitor
Configuring your video monitor

Using the joystick to navigate menus
The joystick allows you to navigate through the video monitor menus.

OK Button

Step 1: Press the Menu button on the 
video monitor.

Step 2: Move the joystick up, down, left, 
or right to navigate through the menus.

Step 3: Press down on the OK button to 
confirm a selection or press Menu to 
exit menus without saving changes.

Menu Navigation

Enabling the Auto-Mute feature
The Auto-Mute feature eliminates white noise when monitoring a room by muting the video 
monitor when the camera detects no audible noise. Once the camera detects a sound, the 
video monitor plays sound again.

To enable Auto-Mute:
1 Press the Menu button on the video monitor.

2 Select Auto-Mute ( ) using the joystick 
and press OK.

3 Select ON to enable auto mute.

4 Press the OK button (press down on the 
joystick) to save your settings.
12



Configuring your video monitor
Changing the date and time
To adjust the video monitor’s date and time:

2011-02-14
09:54:30

1 Press the Menu button on the video monitor.

2 Select Settings ( ) and then press the OK 
button.

3 Select Date & Time and then press the OK 
button.

4 Use the joystick to configure the Year, Month, 
Day, Hours, Minutes, and Seconds. 
• Press up/down on the joystick to adjust the values. 
• Press left/right to move between the year, month, and date.
• Time is in 24-hour format.

5 Press the OK button to save your changes, or press Menu to exit the menu without saving 
your changes.

Adjusting the alarm volume
The video monitor can be set to ’beep’ when the 
camera detects audio triggers (e.g. a loud 
noise). You can adjust how loud the video 
monitor beeps when the alarm triggers.

NOTE: To disable the alarm ’beep’ turn 
the volume all the way down.

NOTE: If you have the LW2401AC2 accessory 
camera, the alarm activates when motion 
is detected. 

This is useful if you want to monitor activity in an 
area, but cannot keep your eyes on the video 
monitor.

To change the video alarm volume:
1 Press the Menu button on the video monitor.

2 Select Alarm Volume ( ) and then press the OK button.

3 Press left and right on the joystick to adjust the alarm volume.

4 Press the OK button to save your settings.
13



Configuring your video monitor
Adjusting the screen brightness
To adjust screen brightness:

1 Press the Menu button on the video monitor.

2 Select Settings ( ) and then press the OK 
button.

3 Select Brightness and then press the OK button.

4 Press left and right on the joystick to adjust the 
screen brightness.

5 Press the OK button to save your settings.

Adjusting the timer settings
The timer allows the video monitor to beep after a set duration. If the monitor is used as a 
baby monitor, the timer can help remind you when it is time to feed the baby. 

To enable the Timer:

04:30 Timer 
indicator

00:00

1 Press the Menu button on the video monitor.

2 Select Settings ( ) and then press the 
OK button.

3 Select Timer and then press the OK button.

4 Enter the timer duration using the joystick. 
Press left / right to navigate the values. Press 
up/down to adjust the values. Press OK to 
confirm.
NOTE: Timer duration is represented as 

(Hours: Minutes)

5 Select ON and then press the OK button to 
activate the timer. When the timer duration 
ends, an alarm goes off and the timer resets 
until it is manually disabled.
14



Configuring your video monitor
Adjusting the temperature unit of measurement 
The camera has a built-in temperature 
sensor. You can change the video monitor to 
display temperature in Fahrenheit (F) or 
Celsius (C).
To change the unit of measurement:

1 Press the Menu button on the video monitor.

2 Select Settings ( ) and press the OK 
button.

3 Select Temp. Display and press the OK 
button.

4 Select either C for Celsius or F for 
Fahrenheit.

5 Press the OK button to save your settings.

Configuring the temperature alert range
You can configure the video monitor to alert you 
through alarm beeps, when the temperature 
goes above or below the set temperature range. 
NOTE: Temperature sensor is accurate within 

3°F/1°C.

NOTE: The LW2401AC2 accessory camera does 
not have a temperature sensor. When this 
camera is selected, the temperature 
reading is permanently set to 68°F/20°C.

To configure the temperature alert range:
1 Press the Menu button on the video monitor.

2 Select Settings ( ) and then press the OK 
button.

3 Select Temp. Alert and then press the OK 
button.

4 Using the joystick, press up/down to change selection, left/right to adjust the values:
• Beside Low Temperature, enter the lowest room temperature threshold.
• Beside High Temperature, enter the highest room temperature threshold.

5 Select the ON button and then press OK.
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Configuring your video monitor
Restoring default settings
Restoring your video monitor settings 
returns any setting changes to factory 
default settings

To restore the video monitor factory 
defaults:

1 Press the Menu button on the video 
monitor.

2 Select Settings ( ) and then press the 
OK button.

3 Select Factory Reset and then press the 
OK button.

4 Select Yes, and then press the OK button.
16



Viewing your camera remotely using Skype
Viewing your camera remotely using Skype
Connecting to your video monitor through Skype is a convenient and free* method to view 
your camera from anywhere with an Internet connection.
NOTE: When remotely connecting to your video monitor using Skype, audio monitoring is 

disabled.

How it works
Your computer connects to the Skype server. The Skype server is connected to your home 
computer. Your home computer connects to the video monitor, which captures video from 
the camera.

Skype server Home computer

System requirements
For the latest device compatibility list, visit 
www.lorextechnology.com

iPhone, iPad, iPod Touch Requirements
• Skype for iPhone v. 3.0 and above
• Skype for iPad v. 3.5 and above
• iPhone 4S/4/3GS, iPad (1st generation and above), 

iPod touch (3rd generation and above)
• iOS 4.0 and above
Android Requirements
• Skype v. 2.8 and above
• Android v. 2.3 and above
PC requirements
• Skype for Windows v. 4.2 and above
• Windows XP SP2/Vista/Windows 7
• 1 Ghz or greater processor
For instructions, see “Connecting to Skype on a PC” on page 18.
Mac requirements
• Skype for Mac OS v. 5.3 and above
• Mac OS v. 10.5.8 and above
• 1 GHz or higher Intel processor (PowerPC™ not supported)
For instructions, see “Connecting to Skype on a Mac” on page 24.

Disclaimers
You must have a high-speed 
internet connection to use the 
video function on Skype. Traffic 
congestion may result in 
choppy video.

Mobile Data Charges
When using a mobile cellular 
network, data charges may 
apply. Check with your 
provider for details.

*Computer to computer

For Skype related support, visit 
https://support.skype.com/ 
17
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Viewing your camera remotely using Skype
Connecting to Skype on a PC

Step 1 of 6: Installing the camera driver for PC
You will need to install the camera drivers located on the software CD (included) or 
available as a free download from www.lorextechnology.com.

To install the camera drivers:
1 Insert the software CD into your computer. An Autoplay window opens.

2 Click Run Lorex.exe. 

Run 
Lorex.exe

3 Click the USB Driver button, and then click USB Driver. The driver appears on your desktop.

Click the USB Driver button

Then, click "USB Driver" to copy 
the driver to your desktop.

4 Click the  button to close the window.

5 Double-click the Usbdriver-PC  icon on your desktop.

6 Follow the on-screen instructions to complete the driver installation
18



Viewing your camera remotely using Skype
Step 2 of 6: Connecting the video monitor to the PC
1 Turn on the camera first, then the video monitor. Make sure you can see a video image on 

channel 1. 
NOTE: Pair the camera that is most important for you to view remotely to Channel 1. For 

instructions on how to pair cameras, see “Pairing cameras” on page 40.

2 Connect the mini-USB cable (included) to your video monitor and into the computer’s USB 
port. 

mini-USB cable

The video monitor displays the following: "USB PC CAMERA MODE"

Step 3 of 6: Creating a Skype account
A Skype account allows you to connect to your camera through the Skype service. Skype is 
a service that allows users to make voice calls and video calls to anywhere in the world. 
In order to connect to your video monitor using Skype, you will need two accounts---one 
for the camera (e.g Lorex Camera) and one for yourself (e.g. Tom Smith).
NOTE: The Skype illustrations and instructions below serve as a guideline only. Skype may 

change their website / product interface without prior notice.

If you do not have a Skype account
See “If you do not have a Skype account...” on page 29.
If you have an existing Skype account (PC)
You will have to create a separate account for your camera. Follow the instructions below.

1 Launch Skype. If you are connected to Skype, click Skype>Sign Out.

2 From the Skype Login window, click Create a new account.

Click Create a new account
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Viewing your camera remotely using Skype
3 Follow the on-screen instructions to create a new account. Upon login, the Setting up Skype 
wizard starts. Click Continue. Under Video, you will see an image from the camera. If no 
image appears, make sure the monitor is connected to the computer via the USB cable.

Live video

Continue

Select Wireless Monitoring 
System if necessary

NOTE: If you can see an image from a webcam that is already connected, select Wireless 
Monitoring System from the drop-down menu.

NOTE: If the Setting up Skype wizard does not run, click Tools>Options>Video Settings. 
Make sure you can see video in the window. Click Save to exit. If the image is from 
an already connected webcam, select Wireless Monitoring System under Select 
Webcam.

Live video

Save button

Video Settings

Select Wireless Monitoring 
System if necessary

4 Click Continue.

5 In the next page, click Add later to not include a profile picture for the camera’s Skype 
account, or click Continue and follow the instructions to add a profile picture for the camera’s 
Skype account.

6 Click Start using Skype.
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Viewing your camera remotely using Skype
Step 4 of 6: Configuring Skype

7 Click on Tools>Options.

Options

8 Click the Calls button ( ).

9 Click the Show advanced options button.

Show advanced options

10 Under Allow calls from..., select people in my Contact list only. This will prevent the device 
from accepting Skype calls from anyone who is not in the contact list for its account.

NOTE: You may also select anyone, which will allow anyone with a Skype account to call 
the device and access your camera. This setting is not recommended
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Viewing your camera remotely using Skype
11 Check Answer incoming calls automatically and Start my video automatically when I am in 
a call.

Save

 Click Save.

Step 5 of 6: Send a contact request
Next, you have to send a friend request to your personal account (e.g. Tom Smith).

1 Click the Add a contact button ( ).

Add a contact

2 Search for the name of your personal account (e.g. Tom Smith), and then click the Add button.

Search for the name of your personal 
Skype account

Click Add
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Viewing your camera remotely using Skype
3 Click Send Request.

Send contact request

Step 6 of 6: Test the connection
NOTE: This step requires you to log in to Skype from a different computer or compatible 

mobile device.

1 Log in to your personal account (e.g. Tom Smith).

2 A "new contact" pop-up appears. Click the new contact request icon that appears on the 
bottom-right corner of the window.

3 Click the Add to Contacts button to add the camera to your contact list.
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Viewing your camera remotely using Skype
4 From the contact list, right-click on your camera’s account name (e.g. Lorex Camera), and 
click Call. The video call begins automatically. Please allow around 15 to 25 seconds for the 
video connection to be established.

Call

NOTE: Video may appear pixelated immediately after connecting. It should improve within 
a few seconds, depending on your Internet connection. 

Connecting to Skype on a Mac

Step 1 of 6: Installing the camera driver for Mac OS
You will need to install the camera drivers included on the software CD (included) or 
available as a free download from www.lorextechnology.com. 

1 Insert the software CD into your computer. The Lorex CD icon ( ) appears on your desktop.

2 Double-click the Lorex CD icon ( ) on your desktop.

3 Double-click the Mac folder.

4 Double-click the SD Series Mac Driver.zip file to extract the installer. The installer is saved to 
your Downloads folder and your downloads folder opens automatically.

5 Double-click the SD Series Mac Driver folder and then double-click the 
WirelessCameraMacDriverSuiteInstaller (.pkg) file.

6 Follow the on-screen instructions to install.

Step 2 of 6: Connecting the video monitor or receiver to your computer
1 Turn on your camera first, and then turn on your video monitor or receiver. Make sure you can 

see a video image on Channel 1.
NOTE: Pair the camera that is most important for you to view remotely to Channel 1. For 

instructions on how to pair cameras, see “Pairing cameras” on page 40.
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Viewing your camera remotely using Skype
2 Connect the mini-USB cable (included) from the USB port on your video monitor or receiver 
to an available USB port on your computer. "USB PC CAMERA MODE" appears on the screen.

mini-USB cable

Step 3 of 6: Creating a Skype account
A Skype account allows you to connect to your camera through the Skype service. Skype is 
a service that allows users to make voice and video calls to anywhere in the world. 
In order to connect to your video monitor using Skype, you will need two accounts—one for 
the camera (e.g. Lorex Camera) and one for yourself (e.g. Tom Smith). 
NOTE: The Skype illustrations and instructions below serve as a guideline only. Skype may 

change their website / product interface without prior notice.

If you do not have an existing Skype account:
See “If you do not have a Skype account...” on page 29.

If you have an existing Skype account (Mac):
You have to create a separate account for your camera. Follow the instructions below.

1 Launch Skype. If you are already connected to Skype, click File>Sign Out.

2 Click Create New Account.

Create New 
Account

3 Follow the on-screen instructions to create a new account.
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Viewing your camera remotely using Skype
Step 4 of 6: Configuring Skype
1 Upon login, click Skype>Preferences. Select the Audio/Video tab.

Audio/Video tabCalls tab

2 Under Camera, select Wireless Monitoring System if it is not already selected. You will see 
live video from your camera if your device is connected.
• If the video area is black, check to see if your camera is on and is paired to Channel 1. Also 

check to make sure your video monitor is connected to your computer. 
NOTE: When connecting or reconnecting your video monitor, you must close the 

Preferences window and re-open it to the Audio/Video tab to test the video 
connection.

3 Select the Calls tab.

Answer 
automatically

Click Configure

4 Under Incoming Calls, select Answer Automatically. 

5 Click Configure.
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Viewing your camera remotely using Skype
6 Select Answer automatically with video. Click Done.

Select Answer automatically with video

7 Select the Privacy tab.

8 Under Allow calls from, select Contacts. This will prevent the device from accepting Skype 
calls from anyone who is not in the contact list for its account.

Allow calls 
from Contacts

Privacy tab

NOTE: You may also select Anyone, which will allow anyone with a Skype account to call 
the device and access your camera. This setting is not recommended.

9 Close the Preferences window to return to the main Skype window.

Step 5 of 6: Send a contact request
Next, you have to send a friend request to your personal Skype account (e.g. Tom Smith).

1 From the main Skype window, click Contacts then click Add Contact.

Add Contact
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Viewing your camera remotely using Skype
2 Under Add Contact, enter the Skype account name (e.g. Tom Smith) or email address for your 
personal Skype account. Click Find. Your personal Skype account should appear below the 
search bar.

Enter the account name or 
email address for your 
personal Skype account

Click Find

Send contact request

3 Next to your personal Skype account, click  and then click Send to send the contact 
request.

Step 6 of 6: Test the connection
NOTE: This step requires you to log in to Skype from a different computer or compatible 

mobile device.

1 Log in to your personal account (e.g. Tom Smith).

2 The contact request from your device’s Skype account should appear in the left column under 
Recent. Click the Skype account name for your device.

Contact 
Request

Accept

Call

3 Click Accept.

4 Click the  (Make a Voice Call) button to call your camera. The video call begins 
automatically. Please allow around 15 to 25 seconds for the video connection to be 
established.
• You can also call the camera from the contact list using the  button. Do not use 

the Video Call ( ) button.
NOTE: Video may appear pixelated immediately after connecting. It should improve within 

a few seconds, depending on your Internet connection. 
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Viewing your camera remotely using Skype
If you do not have a Skype account...
Create your personal account first (e.g. Tom Smith), then create a second account for your 
camera (e.g. Lorex Camera). 

Create a personal account (i.e. Tom Smith):
1 Go to www.skype.com, and click on Join Skype.

Join Skype

2 Click Create an Account. Fill in the appropriate fields. 

Create Account

3 Click the I Agree - Continue button.

I Agree - Continue

4 Follow the on-screen instructions to download and install Skype on your computer.

5 Once you are logged in to Skype, click on Skype>Sign out (PC) or File>Sign out (Mac), then 
see “If you have an existing Skype account (PC)” on page 19 or see “If you have an existing 
Skype account (Mac):” on page 25.
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Viewing your camera remotely using Skype
"Personal" Skype account 
(e.g. Tom Smith)

"Camera" Skype account 
(e.g. Lorex Camera)

Skype Name:

Password:

Email address used to register this 
account (used for account retrieval):

Skype Name:

Password:

Email address used to register this 
account (used for account retrieval):

My Skype Account Information

Changing the camera view on Skype
NOTE: This section is applicable only if you have more than 1 camera.

You cannot change the camera remotely using Skype; however, you can change the camera 
that is shown on Skype manually using the video monitor. 
Pair the camera that is most important for you to view remotely to Channel 1. When you 
connect the USB cable to the video monitor, the video monitor defaults to Camera 1, even 
if you have a different channel selected.

To change the camera view:
• From your video monitor, press CAM to change cameras.
• The camera number changes to the next connected camera. 

NOTE: You can only view one camera at a time

Press CAM to change cameras

Cam 2

USB PC CAMERA MODE

Camera number
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Viewing your camera remotely using Skype
Viewing a camera on your smart phone or tablet
You can remotely monitor your camera using Skype on supported smart phones or tablets. 

Supported apps & devices 
For the latest device compatibility list, visit www.lorextechnology.com

iPhone / iPad / iPod touch
• Skype for iPhone v. 3.0 and above
• Skype for iPad v. 3.5 and above
• iPhone 4S/4/3GS, iPad (1st generation and above), iPod touch (3rd generation and above)
• iOS 4.0 and above

Android
• Skype v. 2.8 and above
• Android v. 2.3 and above

Prerequisites
• Install and configure the PC/Mac Skype software and USB drivers. For details, see “Viewing 

your camera remotely using Skype” on page 17.
• Ensure the video monitor is connected to your computer with the USB cable.
• Ensure you have configured your camera’s Skype account to auto-accept incoming calls.
• Ensure your personal Skype account has been added to the contact list for the video monitor’s 

Skype account.

Viewing your camera on iPhone
1 Download and install the Skype application from the App Store.

NOTE: Skype is a free application, but it requires a valid iTunes account to download.

2 Launch Skype and sign in using your personal account. Your contact list opens to All 
Contacts. If a different contact list is open, tap Contacts and then tap All Contacts.

3 Select the video monitor’s account, and tap 
Voice Call to connect to the camera. The 
video call connects automatically. Please 
allow 15 to 25 seconds for the call to 
connect.

Voice Call button

NOTE: Video may appear pixelated 
immediately after connecting. It 
should improve within a few seconds, 
depending on your Internet 
connection. 
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Viewing your camera remotely using Skype
Viewing your camera on iPad
1 Download and install the Skype for iPad application from the App Store. 

NOTE: Skype for iPad is a free application, but it requires a valid iTunes account to download.

2 Launch Skype and sign in using your personal account. Your contact list opens to All 

Contacts. If a different contact list is open, tap Lists ( ) and then tap All Contacts.

3 Select the video monitor’s 
account, and tap Voice Call to 
connect to the camera. The 
video call connects 
automatically. Please allow 15 
to 25 seconds for the call to 
connect.

Voice Call button

NOTE: Video may appear 
pixelated immediately 
after connecting. It 
should improve within a 
few seconds, depending 
on your Internet 
connection.

Viewing your camera on an Android smartphone or tablet
1 Download and install the Skype application from the Google Play Store.

NOTE: Skype is a free application.

2 Launch Skype and sign using your personal account.

3 Tap Contacts.

Contacts
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Viewing your camera remotely using Skype
4 Tap the name of the video monitor’s account, and tap Voice Call to connect to the camera. The 
video call connects automatically. Please allow 15 to 25 seconds for the call to connect.

Voice call button

NOTE: Video may appear pixelated immediately after connecting. It should improve within 
a few seconds, depending on your Internet connection.
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Troubleshooting
Troubleshooting
Problem Possible Causes Solution

No picture or sound 
on the monitor

• The monitor may be off.
• The batteries on the video 

monitor may be low.
• The monitor may be in Scan 

mode.

• Ensure that both the camera and 
monitor are turned on.

• Ensure that the monitor is plugged in 
and fully charged

• Press the Scan button to turn off Scan 
mode.

Monitor produces a 
high-pitched noise 
(squealing)

• The video monitor and 
camera are too close 
together.

• The video monitor volume 
may be too loud.

• Move the camera and video monitor 
further apart.

• Lower the video monitor volume.

Picture but no sound 
on the monitor

• The volume on the video 
monitor may be too low.

• The Auto-Mute feature may 
be enabled. 

• Turn up the volume on the video 
monitor.

• In the Main Menu select Auto-Mute, 
then turn the setting Off.

Sound but no picture 
on monitor

• The video monitor screen 
may be off.

• Press the Video button on the video 
monitor to turn the screen back on.

I get an "Out of 
Range" message on 
the monitor

• The video monitor lost 
connection with the camera.

• The camera may be off.

• Move the video monitor and camera 
closer together.

• Ensure the camera(s) are turned on.

Picture is not clear • The video monitor and 
camera may have a weak 
signal.

• Interference from the 
environment (from 
microwaves, wireless 
routers, etc.)

• Brightness on the video 
monitor may be too low.

• Move monitor closer to the camera.
• Move the monitor away from other 

wireless devices (e.g. wireless 
routers, cordless phones, 
walkie-talkies, etc).

• Adjust the brightness on the video 
monitor 
(Menu>Settings>Brightness).

The video monitor 
does not turn on

• The video monitor may have 
low batteries.

• Connect a power adapter to the video 
monitor and a power outlet to charge 
the monitor. Charge the monitor for 
4.5 hours.
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Troubleshooting
Troubleshooting (continued)

Problem Possible Causes Solution

Incorrect temperature 
reading

• The camera may be under 
direct sunlight.

• Temperature sensor is 
accurate within 3°F/1°C.

• Temperature setting on 
LW2401AC2 accessory 
camera is permanently set to 
68°F/20°C.

• Move the camera to an area away from 
direct sunlight.

I’m connected to 
Skype, but I don’t see 
any video

• The video monitor may be on 
the wrong channel.

• The camera(s) may be off.
• Handheld monitor may not 

be connected to computer.
• USB drivers may not be 

installed.
• USB port may be broken.
• Auto-answer is not enabled.

• Press right on the joystick to change 
to the correct channel.

• Ensure the camera has power, and is 
turned on.

• Launch Skype, then click 
Tools>Options>Video Settings (PC) 
or Skype>Preferences>Audio/
Video (Mac). Ensure you can see the 
video on Skype

• Ensure the handheld monitor is 
connected to the computer via the 
USB cable.

• Insert the driver CD and install the 
USB driver or download USB drivers 
from www.lorextechnology.com.

• Change the USB port the video 
monitor is connected to.

• For instruction on how to configure 
Skype to auto-answer incoming calls, 
see page 21 for PC or page 26 for Mac.

I can’t see video on 
my mobile device

• Outdated version of Skype.
• Camera drivers may not be 

installed.
• Viewing on a non-supported 

mobile device.

• Install the latest version of Skype on 
your mobile device.

• Ensure the camera drivers are 
installed from the CD or 
www.lorextechnology.com.

• Ensure the device is compatible with 
Skype. For a compatibility list, visit 
www.lorextechnology.com

Video for webcam is 
shown on Skype 
instead of video moni-
tor.

• Video monitor has not been 
selected as Skype camera.

• (PC) In Skype, click 
Tools>Options>Video Settings and 
select Wireless Monitoring System 
under Select Webcam.

• (Mac) In Skype, click 
Skype>Preferences>Audio/Video 
and select Wireless Monitoring 
System above the video area.
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Frequently asked questions

Q: I have Skype. Why do I need to create a Skype account for the video 
monitor?
A: The video monitor requires a Skype account so you can access the camera(s) from your 
personal Skype account. Setup the video monitor for Skype viewing (for instructions, see 
“Viewing your camera remotely using Skype” on page 17). Then create a Skype account for 
the video monitor and add your personal Skype account to its Contacts. You access the 
camera by calling it - just like calling any one of your Skype contacts.

Q: Why can't I see an image from the camera(s) in Skype?
A: Is this the first time you are setting up the video monitor for remote viewing? If so, follow 
the instructions in “Viewing your camera remotely using Skype” on page 17.
If you have already performed the initial setup, and still cannot access your camera(s) (or 
the video monitor appears as 'Offline'), check the following:
• Have you configured Skype to auto-answer incoming calls. For instruction on how to configure 

Skype to auto-answer incoming calls, see page 21 for PC or page 26 for Mac.
• Is the camera you want to view paired to Channel 1 or the channel selected on the video 

monitor?
• Is the handheld monitor connected to the computer?
• Are the camera and handheld monitor powered on?
• Is the computer powered on?
• Is the computer in Sleep mode or Hibernate mode? The video monitor will not be able to 

connect to Skype if the computer is in Sleep or Hibernate mode.
• Is Skype running on the computer and is the video monitor’s account signed in?
• Have you created a Skype account for the video monitor?
• Have you added your personal Skype account to the video monitor’s contact list?
• Do you have the latest version of Skype installed on your computer and/or mobile device?

Q: What Skype app do I use to connect to the video monitor on my iPhone, 
iPad, or Android device?
A: For the iPhone, use the Skype app. For the iPad, use the Skype for iPad app. For 
Android, use the Skype app. All apps are available for free from the Apple App Store or 
Google Play Store.

Q: How do I pair cameras?
A: The camera included with your device has already been paired up with the handheld 
monitor. If for any reason your monitor and camera are not paired up, or you wish to add 
additional cameras, please perform the following:

1 Place the camera and video monitor 12 inches apart. Turn on the camera first and then the 
video monitor.
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2 Press the Menu button on the monitor, then select Pairing and press the OK button.

3 Select an available channel, and press the OK button.
NOTE: By default, the camera included with the system is paired to Channel 1.

4 Press the PAIR button behind the camera within 30 seconds. You should immediately see 
video from the camera on the video monitor.
NOTE: You can add a maximum of four (4) wireless cameras to the handheld monitor.

Q: Why is my picture at night time not as clear via Skype compared to my 
handheld monitor?
A: Video is transmitted at a 
resolution of QVGA (320x240). 
When viewing on your 
computer,

Pop up mode Default view

 typically the viewing 
screen is larger than the 
handheld monitor, resulting in 
a stretched image to fit the 
screen-size. This is even more 
evident in night vision mode. In 
Skype, we recommended using 
"pop up mode" (image 1) for 
better clarity compared to 
default view (image 2).
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Add-on cameras and accessories
The camera(s) included with your system depends on the model number of your device. The 
cameras and accessories shown below are all compatible with the video monitor system 
and are available from www.lorextechnology.com. The video monitor supports up to 4 
cameras and can support a mix of compatible cameras.

LW2401AC1 Camera


Accessory #: LW2401AC1
• Wall mountable
• Includes night light
• Takes AA batteries (optional, not 

included) or rechargeable battery 
pack (optional, not included)

LW2451AC1 
Pan-Tilt Camera

Accessory #: LW2451AC1
• Adjustable pan/tilt using the video 

monitor joystick
• Wall mount accessory available
• AC power only

Rechargeable Battery for 
LW2401AC1 Camera

Accessory #: ACC2401BATT
NOT compatible with included camera

Wall Mount for 
LW2451AC1 Camera**

Accessory #: ACCMNT2451

Charging Cradle for 
Video Monitor

Accessory #: ACC241CRDL 

LW2401AC2 Indoor/
Outdoor Camera

Accessory #: LW2401AC2
• Wall/ceiling mountable
• Motion detector for motion alarms
• No volume control, audio alarms, or 

alarm sensitivity control
• No temperature sensor*
• AC power only

*When selected, temperature reading on monitor is permanently set to 68°F / 20°C.
**May not appear exactly as shown.
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Add-on cameras and accessories
Pan/tilt control (requires LW2451AC1)
1 Select the channel the pan/tilt camera is connected to. Ensure you are in full-screen view.

NOTE: You must be in full-screen view to adjust the angle. If the monitor is in Quad view (i.e. showing 
multiple cameras), press SEQ and then CAM to return to full-screen view. If the monitor is 
in Sequence view (i.e. switching between cameras), press CAM to exit Sequence view.

2 Use the joystick on the video monitor to control the camera.

Tilt UP

Tilt DOWN

Pan LEFT
Pan RIGHT

Pan Left/ Right

Tilt Up/Down

NOTE: Pan-tilt control is not available through Skype.
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Pairing cameras
The camera included with the video monitor has already been paired up with the video 
monitor. If for any reason your monitor and camera are not paired up, or you wish to add 
additional cameras, follow the directions below.

To pair a camera to the video monitor:

Pair Button
Press the Pair button 
during the pairing 
process with the video 
monitor. 

1 Place the camera and video monitor 12 
inches apart. Turn on the camera first and 
then the video monitor.

2 Press the Menu button on the monitor, 
then select Pairing and press the OK 
button.

3 Select an available channel, and press the 
OK button.
NOTE: By default, the camera included with 

the system is paired to channel 1.

4 Press the PAIR button on the camera 
within 30 seconds.
• You should immediately see video from the 

camera on the video monitor.

5 OPTIONAL: To pair multiple cameras, 
repeat steps 2~4, selecting a different 
channel in the pairing menu.
You can add a maximum of four (4) wireless 
cameras to the video monitor. Add-on 
cameras are available from 
www.lorextechnology.com (accessory # 
LW2401AC1, LW2451AC1, LW2401AC2).
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Technical specifications
Technical specifications

Camera Specifications

Frequency 2400~2483.5Mhz

Maximum Range 450 ft. (138m) outdoor / 150 ft. (46m) indoor line of sight

Image Sensor 1/5" CMOS sensor

IR LED 8 Pcs.

Power Adapter Voltage 5V 1A

Dimensions 2.8in x 2.4in x 6.1in / 72mm x 62mm x 155mm

Weight 0.25lbs / 0.10kg

Video Monitor Specifications

Frequency 2400~2483.5Mhz

Display size 3.5" TFT LCD

Power adapter voltage  5V 1A

Battery voltage 3.7V Li-Polymer battery (built-in)

Battery Life Up to 4.5 hours

Dimensions 5.0in x 0.7in x 3in / 126mm x 17mm x 76mm

Weight 0.35lbs / 0.16kg
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Cleaning and disposal
Cleaning and disposal
Cleaning
Clean the monitor and camera with a slightly damp cloth or an anti-static cloth. Never use 
cleaning agents or abrasive solvents.
• Do not clean any part of the product with cleaners with thinners or other solvents and 

chemicals. This may cause permanent damage to the product which is not covered by the 
Warranty. When necessary, clean it with a damp cloth.

• Keep your camera and monitor away from hot, humid, pr wet areas or strong sunlight.
• Every effort has been made to ensure high standards of reliability for your video monitor. 

However, if something does go wrong, please do not try to repair it yourself . Contact Customer 
Service for assistance.

Disposal of the device
At the end of the product lifecycle, you should not dispose of this 
product with normal household waste, but take the product to a 
collection point for the recycling of electrical and electronic 
equipment. The symbol on the product, user’s guide and/or box 
indicates this. 
Some of the product materials can be re-used if you take them to a 
recycling point. By reusing some parts or raw materials from used 
products you make an important contribution to the protection of the 
environment.
Please contact your local authorities in case you need more information on the collection 
points in your area. Dispose of the battery pack in an environmentally-friendly manner 
according to your local regulations.
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Notices
Notices
Warning: Any changes or modifications not expressly approved by the grantee of this 
device could void the user's authority to operate the device. 

FCC notice
This device complies with Part 15, subpart C, of the FCC Rules. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this 
device must accept any interference received, including interference that may cause 
undesired operation. The manufacturer is not responsible for any radio or TV interference 
caused by unauthorized modifications to this equipment. Such modifications could void the 
user’s authority to operate the equipment. 
However, it is imperative that the user follows the guidelines in this manual to avoid 
improper usage which may result in damage to the unit, electrical shock and fire hazard 
injury. In order to improve the feature functions and quality of this product, the 
specifications are subject to change without notice from time to time.
Caution: To maintain compliance with the FCC’s RF exposure guidelines, place the camera 
at least 20cm (7.87in) from nearby persons.

IC notice
This device complies with Industry Canada license-exempt RSS standard(s). Operation is 
subject to the following two conditions: (1) this device may not cause interference, and (2) 
this device must accept any interference, including interference that may cause undesired 
operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils 
radio exempts de licence. L'exploitation est autorisée aux deux conditions suivantes: 
(1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit 
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en 
compromettre le fonctionnement.
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Wall mounting your camera
Wall mounting your camera
Determine the camera position that will give you the best view before permanently 
mounting the camera. Ensure the power cable is long enough to power the camera. 

ATTENTION
• Keep cables and wires at least 3 feet (1 meter) away from infants or young 

children. 
• Use the cable clips to keep the power cords out of reach.

To wall mount your camera:
1 Unscrew the camera from the mounting stand.

2 Mark 2 screw holes 1.5in (38mm) apart. See the mounting template for details. Drill the holes 
in the wall.

Camera Mounting Template

1 2

3 Insert the screw anchors (included) into the hole. Lightly tap the anchor into the hole with the 
hammer until the anchor is flush with the wall.

4 Tighten the camera mounting screws into the anchors, leaving 1/4" of the screw exposed.
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Wall mounting your camera
5 Place the mounting stand as shown over the screws and pull down to secure the stand in 
place.

Cable Clip 
Screws (x6)

Camera Mounting 
Screws (x2)

4 5

6 Screw the camera into the mounting stand using the wall mounting hole at the back of the 
camera.

7 Connect the power adapter to the camera.

6 7

8 Use the cable clips to keep the cables out of reach from infants and young children. Use the 
cable clip screws or the adhesive on the back of the cable clips to attach them to walls or 
furniture.
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Wall mounting your camera
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